SAW32Lite / SAW32 / SAWPlus32 Latest Release Info





Note: Full advantage of the new 32 Bit Architecture can only be realized using the NT platform with 96 megs of RAM or higher. Proper handling and prioritizing of MultiThreads and Processors is not fully implemented in the Windows 95/98 platform. A definite increase in performance over the 16 Bit SAW/SAWPlus should be observed in 95/98, but in most cases, to observe the maximum performance increases will require Windows NT. In all cases minimum recommended RAM requirements are 32 megs for SAW32Lite, 64 megs for SAW32 and 96 megs for SAWPlus32. Higher is always recommended. 32 megs is not enough for SAW32/SAWPlus32... eratic and extremely slow performance will most likely occur because Windows will be constantly swapping memory buffers to and from the virtual memory swap file.





Note: The SAW32 family requires a minimum of 256 colors for its graphics. However, to avoid problems with Windows sharing palettes among applications, we strongly reccomend setting your display to 16 Bit (65535) colors. This will eliminate screen color changes and palette corruption that is inherent in the 256 color mode. Note that you might need a video card with more memory in order to reach the higher color setting at high screen resolutions.





Note: If you are running Windows 95/98 we strongly suggest modifying the Virtual Memory SwapFile size by going to the Control Panel/System/System properties/Performance/Virtual memory and set the max and min to the same value to prevent repeated resizing of the swapfile. 16Meg is a good value. Other Windows 95/98 suggestions can be found in the HelpFile under the Troubleshooting Windows95/98 section.





Note: Importing EDL Files from SAW/SAWPlus is a one way operation. Once saved in the SAW32 family, they are no longer useable in SAW/SAWPlus. We suggest creating a new EDL32 folder and copying all SAW/SAWPlus EDL Files that you plan to import into that folder. Then operate on those copies so the originals are still left unchanged.





Note: Many operations will use the Default Beep through the computer speaker as an indication of the operation results. We suggest adjusting the Default Beep sound in the Control Panel Sounds section to NONE, so that these sounds do not play through your soundcard to your speakers. In a studio environment, with loud monitoring, this could be bothersome.



































Version 3.6





Enhancements


*	Updating MTEntry boundaries using the mouse or the U key will now respond to the Auto Zero Cross option and adjust the boundary to the nearest zero cross. When two entries are butt spliced, the zero cross is keyed from the first entry. This could leave the second entry boundary with energy that could create a tick. To correctly adjust butt spliced entries, you should break the butt splice first and adjust each entry separately and then slide the two entries back together.





*	SoundCard Device assignments are now free-form. You can skip devices and freely assign any number of input and output devices independently.





*	The normal record panel is now preceeded with a popup input device selection menu (when more than one device is installed) allowing free input device assignment, no longer dependent on the output device assignment.





*	MultiChannel Record Mode Input assignments have been enhanced. The inputs will assign sequentially down the device list automatically as more channels are placed into record. The sequence will follow from the highest device previously assigned. For instance, if you engage the first record channel, the input assigned will start from 1L. If you change the assignemnt manually to 3L, the following record channels will sequentially continue from there as 3R, 4L, 4R etc. These input assignments no longer depend or follow output track assignments.





*	MultiChannel Record Mode Input assignments have been further enhanced to include a 'Restore To Last Settings Template'. If you open and assign recording channels to your desired settings and then close all channels at once using the Ctrl-key, you may re-open the same template setup by using the Ctrl-key when you engage the first track's record button again. The track assignments are independent... what will restore, are the input assignments, now re-ordered to the next group of sequential tracks.





*	MultiChannel Record Save and Open Template File options have been added to the MultiTrack Menu. You may create a preset Restore Template by setting up your MultiChannel input assigns and then closing them with the Ctrl-Key. The Save Template File may now be used to save this template to disk. The Open Template File option can restore this template so that the next time you engage a Track record button with the Ctrl-Key, the original saved input assignments and number of engaged channels will be restored.





*	A MultiChannel Clear Base FileName option has been added to the MultiTrack menu.





*	The MultiChannel Base FileName and path are now displayed on the MultiTrack Window TitleBar during a MultiChannel recording operation.





*	The allowable Tempo Tick Resolution has been raised to 999. All Tempo calculations are using new logic and high resolution routines to improve accuracy dramatically.





*	The Set Tempo To Marked Measure option has been changed to Set Tempo To Marked Measures. The function now asks you to enter how many measures the marked area represents and will allow you to calculate more accurate tempo values spaced evenely across 8 or 16 or more measures.





*	The Tempo Grid settings now include the ability to snap to tuplet note references by adding a T after the note value... for example 4T will snap to a quarter note tuplet.





*	The Tempo Grid settings now include the ability to snap to dotted note references by adding a D after the note value... for example 4D will snap to a dotted quarter note.





*	A Goto Measure function has been added to Tempo Mode. Clicking in the current position display of the Remote Panel opens a dialog box which allows you to enter a destination measure number.





*	Vari-pitch changes will now create undo files.





*	The last Record Filename is now saved and appears as a starting choice for the next record operation.





*	Fader Volume and Pan Right-Click Reset is now active during playback.





*	A new option has been added to the MultiTrack Menu called Multi-Channel Meter Display Wrapping that allows you to turn meter display wrapping ON and OFF. When this option is ON, the meters will wrap to a new row under the first when they extend off the screen to the right. When set to OFF, the meters will simply disappear off the screen to the right. This can be useful on dual monitor configurations, allowing the meters to be dragged off to the second monitor. This option can be saved with the preferences.





*	A new option has been added to the Options Menu called MultiTrack Soft-Clipping. In the interest of speed and performance, the final output of the MultiTrack normally makes no attempt to adjust for clipping that may occur if the overall mix is too loud. This can cause large audible spikes in the final mix that wrap around from positive to negative polarity or vise versa. These spikes are a very noticeable indication that clipping has occurred, and simply adjusting the individual or output track mix levels can correct the problem. When MultiTrack Soft-Clipping is active, the output summing routines will check each sample for clipping and adjust its value to correct for wrap-around error. This can effectively remove the otherwise loud spikes that would occur at the clipping positions. However, if the mix is consistently too loud, the waveform will take on a squashed or flattened characteristic at the clipped areas resulting in a more common form of harmonic distortion. The use of this option adds extra CPU overhead to the mixing process. Another consideration is that clipped areas could possibly slip by unnoticed during the final mixdown process, only to be discovered at a later time. In many cases, the wrap-around audio spikes can more easily warn you of a clipping problem so that it can be addressed immediately before the completion of the project. This setting can be saved with your preferences.





*	Default File Paths for Open SoundFile, Record SoundFile, and Open/Save EditListFile are now set in the Directory Path Setup selection in the Options Menu. There is also a Browse button in the selection window. Simply click into one of the path selection edit boxes and then click the Browse button to browse for that path. This change compensates for differences in the Win98 and WinNT2000 handling of the Windows Common Dialog Functions.





*	The Open button in the file dialog box for deleting SoundFiles and EditListFiles now displays as Delete for more clarification.





*	A small color change was introduced for the SoundFile View wave pen and the MultiTrack View Entry brush. These and other colors can be modified using the Color Setup option in the Options Menu.








Bug Fixes


*	Retake information for MultiChannel Recording is now cleared every time a change is made to the current active record setup to avoid potential file destruction under certain input card re-assignment conditions.





*	Mix Changes placed on MTEntry boundaries and within blank areas are now handled correctly with regard to slopes being cancelled. This eliminates volume bleed thrus and other quirks due to certain positioning calculations not being properly detected.





*	Fixed problem which reported incorrect Smpte Formats to FX plug-ins when Conform 30 to 29.97 is active.





*	Fixed ZeroCross detection problem when MT Cursor position was very close to MT Entry boundary.





*	Vari-Pitch and orphan mix change interactions that could cause page fault errors have been corrected.





*	6db Crossfades with starting volumes above +6db will no longer cause a pagefault. These crossfades will not attain the 6db down crossover point, however. Both tracks starting volumes should be equal for that to occur.








>---<











Version 3.5





Enhancements


*	Introduction of the new SAW32Lite product.





*	Includes the new DirectXLinker 1.5.





*	A new Forced Record Stop command has been added which can be used to escape from Soundcard driver lockups during record. When record mode will not stop in the case of a driver problem, pressing the Ctrl key while clicking the stop button will force an immediate termination and close of the driver without waiting for all buffers to be returned.





*	SMPTE Trigger and SMPTE Generate will now advance the starting position to the next exact EVEN frame before initiating playback or record. This enhances the accuracy of drivers and hardware that can only resolve to MTC quarter frame 0 starting positions. Odd frame boundaries are usually skipped or interpolated on these systems and can cause random position results.








BugFixes


*	The Split Region keyboard shortcuts have been added to the SoundFile View.





*	The BuildMix To FX Modules function in will now correctly pass DirectX processing thru to following plug-ins.





*	All modifications performed in the DirectXLinker will now correctly pass thru to the SAW host program to properly notify the user of EDL changes when closing EDL's or the program itself.





*	The Enter MIDI Custom Command dialog box now correctly allows the maximum of 26 hex values with the comma seperators.





*	The Enter MIDI Program Change dialog box now correctly limits to 6 characters for the entry of one MIDI Program Change according to the exampled format.





*	Tempo Mode TimeLine display now correctly displays large measure count positions without a divide overflow condition.





*	Modification to allow last soundcard device in the Audio Hardware Setup list to be changed to NONE, without reseting the entire setup..








>----<











Version 3.4





Enhancements


*	Support for the new SAW API Version 1.5 with extended FX Function Control.





*	The Track Out Select popup menu in The MultiTrack now includes a progressive Channel Out reference as well as the Device Out reference.





*	The MultiChannel Record Input Selection popup menu now includes a progressive Channel In reference as well as the Device In reference.





*	The Split/Keep Function shortcut key has been changed to a single 'K' key and the confirmation prompt has been removed for higher efficiency. Pressing Ctrl at the same time activates the split across all tracks below the current HotTrack.





*	The Split/Remove Function shortcut key has been changed to a single 'R' key and the confirmation prompt has been removed for higher efficiency. Pressing Ctrl at the same time activates the split across all tracks below the current HotTrack.





*	The Split/Delete Function shortcut key has been changed to a single 'D' key and the confirmation prompt has been removed for higher efficiency. Pressing Ctrl at the same time activates the split across all tracks below the current HotTrack.





*	The Split/Mark Function shortcut key has been changed to a 'Shift-M' key and the confirmation prompt has been removed for higher efficiency. Pressing Ctrl at the same time activates the split across all tracks below the current HotTrack.





*	The Markers View Window will now allow the use of the K, R, and D keys to split Multitrack Entries at the selected Marker position, without the need to switch active windows to the MultiTrack View.











BugFixes


*	SoundFile Loop-Scrubbing has been fixed.





*	The SplitRegion functions have been adjusted to eliminate Divide By Zero errors under certain conditions when using the SplitRegion ToolBar with Auto Zero Cross Detection activated.





*	Butt-Spliced MultiTrack Entries will now correctly adjust individual region boundaries when the splice point is moved beyond the file limit of either entry durimg an entry splice point adjustment.





*	The Sequence View TitleBar Entry Count now displays correctly even if tracks are arranged out of order.





*	Disk Time Remaining in the Record Panels will now display correct values on large drives in Win 98 and Win 95 OSR2. Win NT has always displayed correct values. Early versions of Win 95 will still display correct values only up to a 2 gig drive size.








>----<











Version 3.3





Enhancements


*	The Main program engine and all FX Modules have been updated to version 1.4 API.





*	MultiTrack Playback and SRP Recording now display a Power Reserve value that indicates how much processing power is available during the MultiTrack processing loop. The value is displayed from 99% to 0% in the Remote Transport Window in the Marked/Relative display area, indicating the level at which the MultiTrack buffer processing is progressing. Higher numbers indicate that the MultiTrack loop is completing its track processing with time left over before the soundcard demands the next buffer. Lower numbers indicate that the processing load is struggling to keep up with the soundcard demands. As this value aproaches 0%, the 'Machine Too Slow Message' is very close at hand.





*	Pressing the Ctrl-Key and the BackSpace Key in Select Mode will now copy and duplicate all selected entries to the current MT Cursor position.





*	Pressing the Ctrl-Key and the CLRALL button on any fader, will now clear all mix changes on all tracks.





*	Pressing the Shift-Key and the Retake button on the Record Panel or MultiChannel Record Retake Toolbar, will now allow retake file and MT Entry positioning to the current MultiTrack Cursor position. If you would like to retake only part of the last recording, place the MultiTrack Cursor at the position within the last recorded MT Entry, and press the Shift-Key and Retake button. The file position will be reset to the correct position in the recorded file and the MT Entry will be updated to match the cursor position.





*	Position tracking during MultiTrack playback resolution has been increased by a factor of 10. This allows for much more acurate tracking of all position related timing events such as used by the AVI Viewer.





*	Added Mix-Change Count display in the Seq View Title Bar... #Seq Entries/#Mix Changes.





*	Using the Shift Key when pressing a SOLO button will leave any plug-in return track active, so effects returns will still be heard.











BugFixes


*	Changes have been added to help palette refreshing problems when using displays set to 256 colors.





*	The Hide/Show button will now restore the program to its last set size... instead of forcing the restore to Maximize.





*	The CrossFade routine has been altered to correctly keep fade-in volumes at mute until actual ramp up begins. Also FADE END points are now correctly established.





*	Split Deletes or other region deletes that pull following data forward could cause EDL corruption when there were more than 3000 mix changes on any particular track. This has been corrected.





*	The Midi Hardware Setup Window, Sync Device In listbox now correctly uses the IQS font.








>----<











Version 3.2





Enhancements


*	Version 1.2 of the DirectXLinker is included, which allows for automatic detection and insertion of MONO plugins. When a MONO plugin is inserted, a notice will be displayed in the Linker Title Bar and the data will be handled as Mono data. The left and right channels will be summed to mono and returned as mono data on both the left and right channels. Stereo plugins may still be patched in the same Linker, but will be treated as MONO. Patching a seperate Linker into the same channel will allow stereo plugins to remain as stereo.








BugFixes


*	Includes the VSTLinker 1.1 which fixes graphic display problems for certain plug-ins that draw their own setup windows.





*	The FX CompLimiter module was modified to eliminate possible divide overflows under certain conditions and settings involving the Average Normalize Mode.





*	MIDI Note Off triggering of Marker or Region Playback now correctly responds to the Note Off signal even if playback is still active when the new note is triggered.





*	Modifications were made to the Break Entry and Wait For Time code to clear the last buffer of any extra data from other tracks that follow in the MultiTrack, eliminating any premature leakage of upcoming audio data.





*	The MultiTrack Record KeepTake function has been corrected to work properly on tracks that have been re-ordered and are no longer in low to high sequence.





*	The Conversion Rate adjustment during a BuildMix operation is now properly activated again after being de-activated during a BuildMix To FX Modules operation that has been cancelled.





*	Beginning a Drag and Drop Region from the SoundFile View to an overlapped MultiTrack View, will no longer leave random region outlines behind on the MultiTrack window.





*	Toggling Select Mode On/Off with multiple faders open will no longer leave mix change trace lines on the timeline display.





*	Cursor positioning after a Break Entry with the Auto MT PreLoad After Break option active, will now position correctly at the end of the Break Entry.








>----<











Version 3.1





Enhancements


*	DirectX hosting is now active in the SAW32/SAWPlus32 MultiTrack. The Patch Builder window now includes the DirectXLinker module. Adding the Linker to the current patch will display a list of all installed DirectX Filters. You must have DirectX 5.x installed in Win95 and WinNT ( WinNT must be on Service Pack 3 also). Win98 already includes this.





*	The Retake All function warning box is now more intense than the regular Retake warning box and uses the red circle with the X icon as an indication of a stronger warning.








BugFixes


*	Changing HotTracks with the Arrow keys and autotracking FX changes with an FX module open will now correctly keep focus in the MultiTrack, eliminating the apparent lockup of the arrow key control.





*	Changing the MT Rate with Break or other Control Sequence Entries in the MultiTrack will no longer cause an address fault or divide by zero error.





*	The EQ, CompLimiter and Echo FX modules now correctly save preferences to the SAW parent directory. Track numbers in the dropdown Track Selection listbox are now correctly displayed and will react properly even to tracks that were patched out of order. The About window will now correctly dissapear when any key or mouse click is activated.





*	Mix Change slopes on Region boundaries following small empty sections are now handled correctly regardless of the play starting position.








>----<











Version 3.0





Enhancements


*	The CompLimiter Message Window warning about PeakLimit and Normalize functions not being engaged during normal playback, can now be moved and positioned anywhere on the screen, and it will retain its position during the entire current working session.





*	EQ Parameter Continuous Adjustment monitoring is now available as an option. Click on the IQS Logo icon to open a popup menu and activate the Continuous Adjusment Tracking option. This will allow continuous monitoring of all EQ parameter adjustments... LIVE... instead of waiting for the mouse button to be released. BE AWARE... This is performing continuous MultiTrack Re-Cueing and is extremely CPU intensive... solo a few tracks or make sure to have a killer machine. You may save this option with the EQ preferences.





*	The EQ, CompLimiter and Echo modules will now stay open after switching HotTracks or closing the FX Patch Builder Window. They now have a reference Track number display. Opening a new EQ, CompLimiter, or Echo on another track will change parameters and Track reference numbers on the same open window. You may click in the Track Number display to popup a list selection of all assigned tracks, and select another track to view. There is also an Auto Tracking option as one of the choices, which allows the display to track the current HotTrack selection in the MultiTrack View. If this option is selected, each time the MultiTrack HotTrack is changed to a track that has one of these effects patched, the display parameters will switch and reference that track's settings. Click anywhere in the module window to close the popup listbox without changing selections. The Auto Tracking option may be saved with the module preferences. Note that when loading existing EDL's which contain FX patches, the Track reference list will not show all assigned modules at first, because this information was not saved in earlier versions. Opening the FX Patch Builder window and double clicking each assigned FX will build the corresponding Track reference list, which will save when you save the EDL in this version.





*	The EQ, CompLimiter and Echo modules now have a Bypass switch that allows bypassing just this particular module, leaving other patches on the track active. This setting saves with the EDL. When the Bypass button on the CompLimiter is active, the popup warning message for realtime playback cancellation of PeakLimit and Normalize functions does not display.





*	The EQ, CompLimiter and Echo modules now allow Start and Stop MT Playback by Right-Clicking in the module window in a non-active Right-Click parameter zone.





*	The CompLimiter Gate routine has been enhanced to deliver smoother attacks and releases even on sustained sounds like bass guitar. Both the 16 bit and 24 bit routines have been modified with routines similar in resolution to the slopes on the MultiTrack Faders. Note that presets for attack and release settings might react differently from the old routine and should be re-adjusted in EDL's that contain active gates patched in.





*	The Auto Rewind button is now active during MultiTrack Play and Record modes. You may disengage the Auto Rewind during playback and then stop without loosing your current cursor position.





*	Build Mix To Output Track and Build Mix To New SoundFile now retain the last mix filename and use it as a default the next time around.








BugFixes


*	Force FX Pre-Scan Playback should now work consitently with or without a MultiTrack marked area.





*	The Color Adjust Window is now correctly trapped from allowing more than one to be opened at the same time.





*	MultiTrack Play Looping will now correctly continue normal playback if the marked area is cleared while playing the loop.





*	The Current Slope Factor is now applied correctly to the Sweep Pan function.





*	Modifications were made to keep the PgUp key from being locked out if the MultiTrack View happened to size exactly to the screen size.





*	SMPTE Generate for the Opcode 64XTC and 128X has been corrected.





*	Setting an Offset for the Snap Selected Entry To Offset function, now works correctly at all times in the MultiTrack.





*	Modifications were made to the RecRdy routine to compensate for certain drivers that do not like to be reset without first actually exercising buffer transactions. This should fix compatibility problems with the Fast AV Master audio driver.





*	Modifications to eliminate MultiTrack Cursor display problems during certain Undo/Redo and Restore EDL functions.





*	Select Mode Snap To Cursor and Snap To SMPTE will now warn you of an invalid Key Entry after an Undo or Redo, instead of snapping to the wrong location.








>----<











Version 2.9





Enhancements


*	A new Menu Option has been added to the Edit Menu called Save Marked (SoundFile) To Undo. This option allows you to mark a SoundFile area and save that data to the Undo File. You may then proceed to alter and manipulate the file (as in Sample-Edit Mode), and later, restore the file by recalling the Undo file with the Edit Undo function. Realize, that any destructive operation you perform that writes to the Undo File will overwrite the saved Undo file, since there is only one level of SoundFile Undo.





*	The Delete SoundFile option has been enhanced to allow the current EDL to remain active during the process. All associated regions and MTEntries of the open EDL will be deleted before deleting the file.








BugFixes


*	While actively engaged in a Sample-Edit Mode sample value change, the right mouse button will no longer initiate playback.





*	BuildMix To FX Modules now correctly responds to a MultiTrack Marked Area for the operation. Also, the Rate Conversion selection is correctly locked out for this function.





*	BuildMix To New SoundFile with a SampleRate conversion as part of the process now correctly adjusts the marked area in the SoundFile View after the build.





*	The MT SampleRate button is now locked out when the record panel or MC Record is active.





*	The Get EDL Region Add button is now handled properly when error messages are displayed. It no longer sticks in the ON position causing later screen re-draw problems.





*	If the Forced FX Pre-Scan Playback function is activated with a marked area present in the MultiTrack, the entire marked area is now scanned, regardless of the MultiTrack Cursor position, and then the MT Cursor is re-positioned to the marked area begin boundary, and playback begins from there.





*	BuildMix background processing now passes paint messages through when SAW is restored, to allow for complete screen updates even during the continued processing loop.





*	The Record Remote Drive Display letter will now be correctly refreshed and displayed, eliminating any left-over pixels from the last drive letter.





*	Clicking in the Out sections of the MultiTrack tracks is now correctly trapped on the Output Tracks.





*	Using the BuildMix options with no active tracks of data to build is now properly trapped and will not cause a pagefault.








>----<








Version 2.8





Enhancements


*	The BuildMix To New SoundFile now marks and highlites the build data in the SoundFile View Window. This allows a Region of the mixed data to be instantly created and utilized if desired.








BugFixes


*	Output Track Mix Changes with active FX Plug-Ins will no longer cause Page Fault Errors.





*	Saving an EDL which contains the max number of mix entries on one or more tracks will no longer cause an improper EDL Format error when trying to re-open the EDL.





*	Using the Delete SoundFile or Delete EditListFile function will now automatically close any open EDL File. You will be prompted to Save your current work if needed. This eliminates problems for files which are referenced in the current EDL.





>----<








Version 2.7





Enhancements


*	Tempo Beats Per Minute resolution has been enhanced to 1/1000.





*	The FX Echo Module has been enhanced. The Vol Trim knob now represents the Source Vol Level, which adjusts the level of the original signal in the output mix. Dropping the level to zero will remove the original source signal completely, leaving only the echos and delays. The Delay Milliseconds can now be adjusted in 1 ms steps, 10 ms steps (with Shift key), and 100 ms steps (with Ctrl key). The Percent Feedback can now be adjusted in 1 % steps, 5 % steps (with Shift key), and 10 % steps (with Ctrl key). Right Clicking on one channel's Strength, Delay or Feedback setting will cause it to match the corresponding value of the other channel.





*	The Record Panel Filename displays will now show long paths that do not fit in the allotted space by using dots in the middle, preserving the beginning and end information.








BugFixes


*	Split/Remove on duplicated entries, which was damaged in a version 2.6 modification, now works correctly.





*	Keyboard Focus during Record Modes will now remain active, even after moving and opening various record panel windows.





*	During MT Playback with the MT Display zoomed in beyond the Peak Data Display (cursor is stationary), now when the playback is automatically stopped at the end of the session, the screen display will not jump to the MT end position.





*	Sweep To Next Pan Change now works correctly if there is only one pan change on the track.





*	Offset Fader Mode is now active during MT Play Loop so that overall track levels can be adjusted while the loop area is being played.





*	The FX Patch Builder Window now correctly displays the PostFader Button pushed IN on all Output Tracks, as all FX on the Output Tracks are always processed after the Fader processing, and the button position can not be changed by pressing on it.





*	Using CTRL-Drag to move a mixed Marked area to another track will no longer be confused with the use of the Ctrl key to stretch or shrink a fade. When you grab within an MT Marked Area, the move operation will take the focus. When there is no marked area, the stretch/shrink will take the focus.





*	The Out-Card Select PopUp Menu on the SoundFile View Window will now properly position itself to the left of the readout display regardless of window position and resolution.





*	Since MT Loop Playback mode is dependent on cursor movement to track position, if needed, the Zoom level will automatically be adjusted to the PeakData display level when MT Loop Playback is initiated. During MT Loop playback, the Zoom button will stop operating at the edge of PeakData display level.





>----<








Version 2.6





Enhancements


*	Because of internal changes to the preference file format due to the enhancements in this version, this update will require you to create a new preference file from scratch. PLEASE TAKE NOTE OF IMPORTANT DIRECTORY PATHS AND SETUP OPTIONS BEFORE INSTALLING THIS UPDATE. You will be required to reset all of your Function Key Views as well as your souncard options, and directory paths. This should only take a few minutes and the benefits of the new features in this version should easily offset any inconvenience you might experience.





*	NOTICE: DUE TO THE TRACK AND DEVICE INCREASE IN THIS VERSION, AS WELL AS THE NEW TEMPO ADDITIONS, ALL EDL'S CREATED IN 2.6 ARE NOT BACKWARDS COMPATIBALE TO EARLIER VERSIONS. Please retain a copy of current EDL's before modifying them in this version. If, for some reason, you need to go back to an earlier version, you will need to use the older EDL's.





*	The available tracks in the MultiTrack have been increased for both SAW32 and SAWPlus32. SAW32 now has 16 mono or stereo tracks, while SAWPlus32 now has 32 mono or stereo tracks. All built-in FX have been updated to support the extra tracks.





*	The number of accessable stereo wave devices has been increased for both SAW32 and SAWPlus32. SAW32 can now access up to 6 stereo wave devices (for a total of 12 ins and outs), while SAWPlus32 can access up to 12 stereo wave devices (for a total of 24 ins and outs).





*	A new Menu category has been added to control the TimeLine and MultiTrack Grid options. It is called TimeLine/MT-Grid. The MT TimeLine appearance has been modified to provide a more evenly distributed delineation at each zoom level. Realize that this gives an approximation of current cursor position and the exact position is displayed in the Remote Transport View window. Depending on the zoom level, a wide range of position values will fall within the same pixel reference line, accounting for any apparent readout discrepencies. The Full View and SoundFile TimeLine appearance has been modified slightly. The reference tick mark has been moved from the center to the left edge of the number displays, to maintain some consistency with the new MT TimeLine appearance. 


	


	You may now also display Tempo as well as Time references. The Tempo parameters are completely adjustable and the tempo value of a specific piece of music can be easily and automatically determined by marking 1 measure of the music and using the Set Tempo To Marked Measure option.





	There is also an adjustable Grid that can be used to force MT cursor and MT Entry positioning to exact grid point boundaries. The Grid can be easily toggled On/Off with the 'G' Key. There is no attempt at displaying Grid reference lines on the MultiTrack when the Grid is active, as this would clutter the MultiTrack display beyond usefulness. However, the Remote Transport View Time positon readout title will be bounded by two vertical lines, signaling that the Grid is active. There are individual settings for Time, SMPTE, Sample and Tempo Grids. When the Grid is active, cursor positioning in the MultiTrack will jump to the next Grid point, and no in-between setting will be reachable. During Select Mode Entry moves, positioning will exhibit smooth motion, but when released, Entries will be snapped to the nearest Grid point.


	


	These settings are saved with the Preferences and EDLs and are reset when opening the EDL.


	


	The menu options are as follows:





	Time Mode: Sets the TimeLine to reference Time. If a SMPTE Mode is active then the readout will be SMPTE Time. If the Time/Samples button is set to Sample Mode, Sample display will overide.


	


	Tempo Mode: Sets the TimeLine to reference Tempo in Measures>Beates>Ticks. If the Time/Samples button is set to Sample Mode, Sample display will overide. If active, SMPTE generate and Trigger modes will still function as normal even though the displays reference Tempo. A relative zero may be set to the current cursor position by pressing the SHIFT Key while clicking the Z button in the Remote Transport Window. The relative zero may be cleared by pressing the CTRL Key while clicking the Z button in the Remote Transport Window.





	Set Tempo: Allows you to set the Tempo reference for Tempo Mode. Enter a value within the specified range in the dialog box.





	Set Tempo To Marked Measure: Allows you to automatically determine the tempo of a piece of music. Mark 1 measure of the music and use this option to automatically calculate the tempo.





	Set Time Signature: Allows you to set the Time Signature for the Tempo reference. Enter a value within the specified range in the dialog box.





	Set Tick Resolution: Allows you to set the Ticks per Quarter Note resolution. Enter a value within the specified range in the dialog box.





	Snap To Grid: Toggles the MT Snap To Grid option On/Off. The 'G' Key does the same thing.





	Auto Snap To Grid In Select Mode: Toggles the Auto Snap To Grid In Select Mode option On/Off. When this option is ON, the Grid will automatically activate when entering Select Mode, and automatically de-activate when leaving Select Mode. This allows you to position the cursor normally without Grid snaps, but automatically causes all MT Entry moves to snap to Grid.





	Set Time Grid: Allows you to set the Grid distance for Time mode in MilliSeconds. Enter a value within the specified range in the dialog box.





	Set Samples Grid: Allows you to set the Grid distance for Sample mode in Samples. Enter a value within the specified range in the dialog box.





	Set SMPTE Grid: Allows you to set the Grid distance for SMPTE mode in Frames. Enter a value within the specified range in the dialog box.





	Set Tempo Grid: Allows you to set the Grid distance for Tempo mode in Note-Time references. Enter a value within the specified range in the dialog box.





*	The first installment of the new IQS DirectMidiTC protocol is activated in this version. This is an extended protocol of communication between the MIDI device driver and the SAW application. The first driver to take advantage of this enhanced protocol is the new Antex Studio Card driver for WinNT. It allows SAWPlus32 to read and generate SMPTE directly from the generator hardware itself, effectively bypassing much of the MIDI multimedia overhead normally associated with the MIDI driver MTC method of handling SMPTE code. There is an option for activating the use of this protocol in the Options menu, and a new Generate protocol option was added to allow SMPTE generation with this method. The driver must be capable of the extended IQS DirectMidiTC protocol, for these options to work.





	To use this option with the new Antex Driver, activate the IQS DirectMidiTC Protocol in the Options Menu. Then select the IQS DirectMidiTC Protocol for the Generate SMPTE Protocol in the MIDI Hardware Setup Options. You will now find that you no longer need the MTC Record button pressed in the Antex Mixer to read incoming SMPTE. This eliminates much overhead in the handling of incoming SMPTE messages and can improve overall system performance considerably. The use of this extended protocol also allows a more direct communication between SAW and the SMPTE generator, resulting in more consistent starts when Generating SMPTE as Master. 





*	A New Sequence Control Entry has been added called Wait For Time. This entry can be used in MultiTrack Play Mode to stop the current playback and wait for a specific time in hh:mm:ss AM or PM. When the time is reached, MultiTrack playback will start again. This entry can also be used during SRP Record Mode to start and stop recording at specific times. For example... To create a recording template to automatically record 5 minutes beginning at each hour... place one of these entries set to the starting hour on a track of the MultiTrack... 5 minutes down the track, place another of these entries set to the start of the next hour... and so forth. Engage SRP Record Mode on another track and SRP recording will be started and stopped at each of these Control Entries.





*	Play Mark and Play Loop are now active in the MultiTrack to play or loop within a marked area. The functions are initiated in the same manner as the SoundFile View... either by pressing the appropriate button in the Remote Transport Window, or by pressing Shift-Right Mouse for Play Mark and Ctrl-Right Mouse for Play Loop. The Play Loop is different from the SoundFile View in that it is not seamlessly continuous... playback stops and recues at the beginning again. You also cannot alter the marks during loop playback in the MultiTrack. Note that the MultiTrack zoom is limited to the Peak Data File during MT Mark or Loop playback.





*	Support for Opcode's 64XTC and 128X MIDI interfaces has now been added.





*	When using the Sequence Ctrl Window to add Control Entries to the MultiTrack, now, after pressing the Add To Seq button, the MultiTrack will automatically become the active window, allowing all MultiTrack positioning controls to be immediately active.





*	In the MultiTrack View window, the Up/Dwn Arrow Keys now increment and decrement the current HotTrack. Scrolling the view by one track is now handled by the Shift Up/Dwn Arrow Keys, and scrolling the view a page at a time is still handled by the Ctrl Up/Dwn Arrow Keys.





*	Using the SAVE EditList CopyAs command will now leave the current EDL update flag untouched. This will cause a prompt to save this EDL when opening a new one or exiting the program... since the last saved EDL was a copy and the current one might still contain unsaved changes.





*	The Receive MIDI Trigger setting is now saved with the Preferences and EDLs.





*	Offsetting Mix Changes within a marked area has been enhanced. Now, the end boundary is not included in the offset, and if the marked area contains no current Mix Entries, a new entry will be written at the beginning boundary and the end boundary, allowing you to adjust the volume of an area with one fader move.





*	The upper and lower Slope Values have been slightly skewed for a wider range... Values 1-3 now create slightly slower transitions than before and values 9-10 create faster transitions than before. Slope 10 is now virtually instantaneous for specialized needs.





*	The Record Panel File Type and Resolution setting of Wave Device 1 is now saved in the Preference File. Remember that the SampleRate setting of the MultiTrack is the rate that is saved as the default rate.








BugFixes


*	Building mixes and Pasting to New SoundFiles will now properly handle the .snd or .wav extension when creating the new file header.





*	Full View Window will now retain cursor movements to within the Window boundaries and mouse clicks will be correctly ignored when there is no open SoundFile.





*	MT Record without SRP will now properly initialize the FX modules.





*	Closing the program by right-clicking on the Taskbar while the PatchBuilder Window is open will no longer cause a memory fault error.





*	The Edit Cut Window now always centers within the program's Main Window.





*	Clicking the Left Mouse Button to change the SoundFile play position while playing in Transcribe Mode will no longer produce random positioning results.





*	Pressing a key to start MultiTrack PreLoad playback, now automatically returns focus to the last active window.





*	Output Fader moves that occur during blank areas of the MultiTrack will no longer cause memory fault errors.





*	SoundFile View Ruler now displays correctly in Sample Edit Mode.





*	Resizing Fades when multiple faders are open, now works correctly.





*	The Retake function now works correctly even after using the Hide/Show function.





*	Grabbing an unselected entry in Select Mode with the Shift or Ctrl Key, now selects and highlites the entry, correctly updating the boundary reference lines instead of leaving duplicated or disappearing lines behind.





*	Opening SAW6x, and SAWPlus EDls will now correctly set all MIDI Note assigns, including notes which have no assignments. Prior to this release, cleared note assignments were not correctly set and would attempt to trigger Marker playback. To fix these EDLs, open the Assign MIDI Notes dialog box, press the Clear All button and re-save the EDL.





*	ScrollBar positioning calculations in the SoundFile View have been adjusted to correct for variable overun on very long soundfiles.





*	Adjustments made to Break and Loop entry calculations during certain MultiTrack placement configurations, now result in accurate postioning after these entries.





*	Current SMPTE Mode now correctly saves with the Preferences.





*	Mouse vertical position is now locked when extending MT Entry Boundaries. This eliminates chances of slipping across tracks and causing corrupted MT Entries on adjacent tracks.





*	Using the Fader Up/Down Arrows to offset mix changes within a marked area now works correctly.





*	The Recover EditListFile option now correctly restores the very last EDL Undo File.





*	Blend EDL no longer corrupts SF Marker positions of the newly blended EDL.





*	Replace Sequence Entry Conflict detection has been corrected.





*	-6db Crossfades will now correctly mark the fade-in positions so that any fade resizing adjustments will be properly applied.





*	Split/Remove, Split/Delete, Cut/Remove and Cut/Splice functions have been modified to eliminate the problem of deleteing or removing the wrong side of the split under certain naming considtions.





>----<








Version 2.5





Enhancements


*	Because of internal changes to the preference file format due to the enhancements in this version, this update will require you to create a new preference file from scratch. PLEASE TAKE NOTE OF IMPORTANT DIRECTORY PATHS AND SETUP OPTIONS BEFORE INSTALLING THIS UPDATE. You will be required to reset all of your Function Key Views as well as your souncard options, and directory paths. This should only take a few minutes and the benefits of the new features in this version should easily offset any inconvenience you might experience.





*	Regions that are created by directly recording into the MultiTrack will now maintain a Position Stamp of the original recorded position. Using the Ctrl-Key (and the Add To MT Button or the A key) when adding the Region back to the MultiTrack will override the current cursor position and place the Region at the original position on the current HotTrack. This can be very helpful when keeping multiple takes of an overdub... you may easily place those takes on other tracks at a later time, perfectly in sync, using this feature.





*	The Split Region Toolbar has been enhanced to allow the Ctrl-Key to extend ALL Toolbar functions to include all tracks from the current HotTrack down.








BugFixes


*	SRP recording problem in normal timing mode has been corrected. This problem was introduced in version 2.4 due to the Relaxed Record Timing feature... when this feature was off, the default buffer size was actually being cut to half of what it should have been.





*	Midi Trigger now works correctly in WinNT.





*	Midi Trigger Marker Play now works correctly.





*	Midi Trigger now filters keyboards that transmit Active Sensing MIDI commands for better response time.





*	Left Arrow key in MultiTrack now correctly stops when MultiTrack Position is zero.





*	Fixes a memory instruction fault that would occur when pressing the T/S button on the Remote Panel while the Update Region Dialog Box was open.





*	Time to Sample calculation adjustment for more accurate display in close-in zoom displays.





*	SMPTE ChaseTrigger with active PeakLimit or Normalize patches will no longer lock the program when the SMPTE stops.





*	Receiving the warning msg "Rec Trigger Start Offset Must Be Greater Than Zero" when using MT SMPTE Trigger Record Mode will no longer lock the program.





*	Receiving the warning msg " Start Volume Is Less Than Or Equal To End Volume" when using the crossfade functions will no longer clear any existing mix changes within the crossfade area. The area will only be affected if the crossfade function completes.








>----<








Version 2.4b





Enhancements





BugFixes


*	Code Adjustment made to avoid compiler optimization problems which caused crash when adjusting loop boundaries during playback.








>----<








Version 2.4





Enhancements


*	The Force FX Pre-Scan / Playback option will now pause at the end of the Pre-Scan and wait for you to click OK or press any key to actually start playback. This gives the user a chance to initiate a DAT record mode or otherwise initiate some special operation just prior to playback.





*	Two new MIDI Sequence Ctrl entries have been added to the Sequence Ctrl list; MIDI Custom Cmd and MIDI Prgm Chng. These MultiTrack Ctrl Entries can be used to send MIDI commands out through the MIDI Out Device, in sync with the MultiTrack playback. The MIDI Custom Cmd allows you to enter a series of HEX values which can be used to control any external device that accepts MIDI control data. The MIDI Prgm Chng allows you to enter a MIDI channel and program number which can be used to control external devices that accept program change data to change device settings. These new MTEntries can be moved, copied and otherwise positioned in sync with other tracks to send lighting commands, external FX program changes, etc, direct from the SAW MultiTrack.





*	The ESC Key or a Right Mouse Click may now be used to cancel after a completed MultiTrack PreLoad.





*	SMPTE Generate Protocol support has been added for the Applied Magic OnStage audio card.





*	The Regions View Window now displays the Region Count and File Count in the Title Bar as #Regions/#Files.





*	The Sequence View Window now displays the MultiTrack Entry Count of the HotTrack in the Title Bar.





*	Adjusting butt-spliced MTEntry boundaries in the MultiTrack using the Shift Key while grabbing the boundary, normally adjusts both sides of the splice. Pressing the Ctrl Key also, will now break the butt-splice and adjust only the boundary of the MTEntry which is under the cursor when the grab is initiated.





*	MultiTrack Screen scrolling will now occur when using the left or right arrow keys to move the MultiTrack cursor and the screen edges are reached.





*	The Regions View now allows the use of the Insert Key on the keyboard to Add the currently selected Region to the HotTrack in the MultiTrack at the MultiTrack Cursor position.





*	A new option called Relaxed Record Timing has been added to the Options Menu. When this option is activated, the record buffer size is doubled which relaxes the timing between interrupts during recording. This option can be helpful when using multiple card recording. If you are experiencing glitches or audio dropouts during recording, try activating this option. Note that the record meter timing will be very sluggish compared to normal record timing. The margin and peak information, however, will still be accurate.








BugFixes


*	Transcribe Mode Cursor will now properly stop at the zero position when continuing to backstep towards the beginning of the file.





*	Transcribe Mode SoundFile View readout will now correctly display when any SMPTE Mode is active.





*	Deleting SoundFiles that are currently open in the SoundFile View will now work correctly the first time.





*	Pan Sweeps are now correctly written even when Offset Volume and Pan values exist.





*	Pressing the Spacebar for MultiTrack PreLoad/Play from the Sequence View and Marker View, now functions correctly.





*	Dissapearing Mix Changes on Region Boundaries during multiple MTEntry moves has been corrected.





*	Output Track Solo playback now correctly bypasses the Fader and FX loop processing to avoid double application of mixdown parameters.





*	Positioning the Record Panel slightly off-screen to the left or top, will no longer result in a dissapearing panel the next time you activate record.





*	Loop To Beginning Seq Control Entries will no longer slip timing of following entries on the same track.





*	Processing FX back to the SoundFile in the MultiTrack will now correctly warn if the FileRate and MultiTrack Session Rate are different, and cancel the Process.





*	A change has been made to correct a problem with the Aux Send/Return module when building mixdowns using FX that require a Pre-Scan.





*	Changes made to the FX Loop to allow faster processing for the Reverb module and Aux Send/Return.





*	Drive Space Remaining in the Record Panel now correctly reports zero bytes free for cd-Roms and removable drives with no disk inserted.





*	SRP Recording with a patched PeakLimit or Normalize in the Multitrack will no longer cause a memory protection fault when the Stop button is pressed.





*	Changing Marked Boundaries in SoundFile View Loop Playback mode will now transition smoothly and assure accurate cursor tracking.








>----<








Version 2.3





Enhancements


*	The Audio Hardware Setup has been altered to allow for separate Device Out and In selections. Use the Toggle Button at the top of the setup window to switch between Out Devices and In Devices. This has been done to handle the newer soundcards with uneven numbers of inputs and outputs. Select the matching Input Device in the same position as the corresponding Output Device. When first running this version, all Input Devices will be deselected. You must set them in place and resave the preferences file before you will be able to record.





*	A new SoundFile View Transcribe Mode option has been added to the Options Menu. This is a special mode of operation useful for transcribing audio dialog into a word processor. When this mode is active, certain elements about the SoundFile View Window change. The TimeLine area is replaced with a Hide/Show button, a time readout display and a Back-Step time display. The SoundFile View Window is now capable of becoming a TopMost Window allowing operation on top of other applications, such as a word processor. Playback operates slightly differently. Beginning playback is handled in any of the normal ways (including the Gameport FootSwitch), but when playback stops, the finished playback position time will be copied into the Windows Clipboard (which can then be easily pasted into your word processor document), and the start cursor position will automatically jump forward to the finished playing position minus the number of seconds of Back-Step, thereby giving an automatic built-in pre-roll for the next playback. This allows for very efficient transcribing, because playback will begin just in front of where you left off each time you start and stop playback. You may adjust the Back-Step time from 0-10 seconds. You may also jump the playback position forward or backward with the Left Mouse button during playback, just like in the Full View Window, allowing you to scan and search for a specific spot in the material to be transcribed. You may also use the PlayMark and PlayLoop features of the SoundFile View to help with difficult sections of material. The operation differs from normal in that the entire marked area will be played or looped regardless of where the starting cursor position is set.





*	A new option has been added to the Mix Menu called Snap Marked MixChanges To Cursor. This option can be used to precisely position mix changes to the MultiTrack Cursor location. For example... re-locating a fade to the exact beginning position of a slightly extended MT Entry Boundary. This option can only be used when track fader is open and a marked mix area exists. Try this... use the fader Next button to snap the cursor to the beginning of a fade. Press the B key to mark the beginning. Place the cursor past the end of the fade and press the E key to mark the end. Use the Tab key to position the cursor at the entry boundaray and select this option from the menu or press the BackSpace key. The fade beginning will snap to the cursor position.





*	Marking Entries in MultiTrack Select Mode has been enhanced. You may now select a range of entries without the need to drag across them. Select the first entry as usual. Then press the Alt-Key while selecting the last entry in the range. All entries inclusive will be selected. This will work across multiple tracks also as long as the last entry is on the same or higher track number.





*	GamePort Switch control now also includes PlayMark (by holding down the Shift Key) and PlayLoop (by holding down the Ctrl Key).





*	GamePort Switch is now active during a MultiTrack Preload waiting condition. 





*	All Message Box prompts have been made TopMost so they will always be visible when first invoked, even on top of other application windows.








BugFixes


*	The Goto Position feature will now create only one instance of the Input Number Dialog Box if you repeatedly click the Time Readout Display in SampleMode.





*	The Waiting For SMPTE Trigger window will no longer dissapear when using MultiChannel Record Mode inputs on soundcard devices 2-8.





*	Active Window Flashing has been adjusted to correctly repaint the title bar when the HelpFile or other application windows overlap it and are then moved.





*	More work done on the Trigger Record and Chase Record and SRP modes to allow total control of punch-in and out when triggering to SMPTE.





*	Clicking in MultiTrack TimeLine will now correctly update marked area display.





*	Scrolling the MultiTrack Display Up or Down while re-ordering a track number, will no longer cause a program fault.





*	The BlendEditList function will now properly blend SEQ Control Entries.








>----<








Version 2.2





Enhancements


*	A new Auto MT PreLoad After Break option has been added to the Options Menu. When this feature is active, the MultiTrack will automatically preload after a Break Entry. A single press of any key will instantly begin playback from the cued state. This is very useful for live playback of multiple cues in a theatre application.





*	SRP Recording with SMPTE Trigger is now sensitive to the SRP/REC link options. You may press SRP alone and after trigger, press REC to punch in live on the fly. You may also use the Shift key to depress both SRP and REC at the same time, or use the Auto SRP/REC Link option in the Options Menu to latch the buttons together.





*	Tempo Mode resolution in the VariPitch FX has been increased to 1/100th of a percent.





*	Extending MT Entry boundaries past the beginning or end of the Region's file, now sets the Entry boundary at the file boundary instead of cancelling the function.





*	A new GOTO Position feature has been added for SMPTE Modes and Sample Position Mode. If any SMPTE Mode is active, clicking with the Left Mouse Button in the Remote Transport Window Current Time Readout display, will pop up the Enter SMPTE Window, allowing you to enter a SMPTE position which the MultiTrack Cursor will jump to. If the Sample Display Mode is active, the same mouse click will pop up the Input Number Dialog Box, allowing you to enter a 10 digit sample position which the MultiTrack Cursor will jump to.





*	The Compressor/Limiter Gate Release sensitivity has been adjusted to give a more useful range of control. Any previously saved EDL's with the Gate function should be checked and possibly re-adjusted. 








BugFixes


*	The Page Fault has been fixed when attempting to start an FX Forced PreScan past the end of a marked area.





*	Loop To Beginning Seq Control Entries will no longer null out following entries on the same track.





*	The use of Shifted keystrokes when creating Region names in an unnamed EDL now works correctly.





*	Deleting a Region which is referencing a bad or missing soundfile, now works correctly.





*	Changing the Slope Value of a mix entry that is within a marked area, now works correctly.








>----<








Version 2.1





Enhancements


*	The FX API has been enhanced to add a Forced Process Request option allowing newer plug-ins to force a processing call right from the track beginning, even if there are no MT  Entries there.





*	A new Blend EditListFile option has been added to the File Menu. This option allows you to blend the File, Region, Marker, Mix and Track Sequence data from an existing EDL into the current EDL at the MultiTrack Cursor position. The position must be chosen after the end of the current EDL. Once the data is on the MultiTrack, it can be positioned anywhere using the Select Mode positioning capabilities.





*	A new Recover EditListFile option has been added to the File Menu. This option can be used to attempt a recover of the last EDL undo operation, even after a system crash. Simply choose this option to see a list of all EDL undo files. Select the session you are trying to recover and hopefully most if not all of your session will be recovered.





*	A new Force FX Pre-Scan/Playback option has been added to the Process/Mixdown Menu. This option can be used to force an FX Pre-Scan and begin immediate playback so that you may hear PeakLimit and Normalize functions live, for example. This is also useful if you want to mix directly to DAT with PeakLimit and Normalize functions, and do not wish to process the data destructively, or build a mix to a separate soundfile. You may also mark an area and force the Pre-Scan from the cursor position to the end of the marked area. In this manner you can test various sections of your session. Be aware, however, that peaks that are outside the marked area are then not included in the Pre-Scan, possibly altering the normalize scaling factors.





*	The Default Undo Data Path option has been added into the Directory Path Setup Option under the Options Menu. Use this to point to a large drive for all undo file storage.








BugFixes


*	Importing EDL's from other versions of SAW will now correctly skipover Track-Order information and properly place Output Track data on the associated Output Tracks.





*	ZoomFactors in the Options Menu are now correctly saved with the preferences.





*	Page Fault Errors due to extreme cases of SampleRate Conversion/Vari-Pitch in the MultiTrack are now trapped. Turning on Waveform display in the MultiTrack will show the entries that are out of range.





*	The Latest Release Notes option under the Info Menu, will now properly work with folder names containing spaces.





*	Zero-Cross detect will now properly adjust the SoundFile View cursor in Sample-Edit mode.








>----<








Version 2.0b





BugFixes


*	This quick version update fixes an Accelerator Key problem discovered in the Sawplus32 2.0 release.








Version 2.0





Enhancements


*	This version marks the first release of the SAW32 spindown. Support has been added for cross-loading EDL's between the different SAW products. You may even load EDL's from SAW products containing more tracks and/or outputs than the version you are using (for example SAWPlus to SAW32). All tracks and/or outputs beyond the current maximums will be thrown away. All output track info will be correctly shifted to the proper output tracks.





*	Brand New Re-Written Help File. Check it out for detailed easy to follow instructions on operating the SAW32/SAWPlus32 environment. Even if you are a seasoned veteran, we suggest reading through it all... you are sure to learn something new about the interface. 








>----<








Version 1.9





Enhancements


*	Support has been added for generating 29.97 with the Opcode 8 PortSE and Studio 64X. If the Conform 30 to 29.97 is turned on with 30 Non Drop Format, 29.97 will be generated.





*	Available SampleRates have been greatly expanded, now including video pull-up and pull-down frequencies of 44056, 44144, 47952 and 48048. A custom rate is now also available, allowing you to specify any SampleRate between 1000 and 99000. Please note that your soundcard must be capable of handling the selected rate or you will be given a warning at play or record time. You may also use the custom rate during a BuildMix operation to create output files for special application hardware.





*	For proper operation in SMPTE DropFrame Mode, the SMPTEStartOffset must be set to an even 10 min boundary. A reminder message will now display when this criteria is not met.





*	A Warning message is now displayed when using Build Mix To Output Track and the selected output file already exists.





*	SAW32/SAWPlus32 now automatically detects and compensates for any system audio device driver changes. If a selected audio device driver is no longer in the same driver list order, SAW32/SAWPlus32 searches and re-orders its device assignments. If it can no longer find an assigned device, it resets all devices and warns you to go to setup options and re-assign the devices.





*	SAW32/SAWPlus32 now automatically detects and compensates for EDL's which use FX Modules that were installed in a different order when the EDL was created. The old FX order is rearranged to match the current order. If an FX was used in the EDL that is not found on the current install, you will be notified and a '<Missing FX Module>' listing will display in the FX Patch List.





*	Pressing the 'A' Key in Select Mode now selects ALL entries in the entire production.





*	Pressing Ctrl-Delete in the Markers View Window now deletes ALL Markers.





*	Build Mix To Output Track now only clears the output tracks that are active in the build. The other output tracks remain untouched.





*	The B Key and the E Key in the MultiTrack View are now sensitive to the Auto ZeroCross option and will now automatically find the nearest ZeroCross before marking the Begin or End point if this option is turned on.





*	The Split Region functions are now sensitive to the Auto ZeroCross option and will now automatically find the nearest ZeroCross before performing the operation if this option is turned on.





*	Break Entries in the MultiTrack will now automatically cue to the end of the Break, ready to play the next entry if one follows immediately.





*	When selecting new entries in the Sequence List and Markers List with the mouse or Up/Down Arrow Keys, playback will now continue at the newly selected entry if playback is already active.





*	Vari-Pitch adjustment using the slide bar has been adjusted to slowly single step up or down when just offset slightly from its center position. As the bar is moved further from center its speed and step size will increase simultaneously.





*	Trying to create a version spinoff (using the Ctrl-Shift 1-9 keyboard option) when the current session has not been previously saved as an EDL File, will now display a message box reminding you to first create and save the session as an Editlist File.





*	Replace Entry in the MultiTrack is now un-doable and will prompt for confirmation when using the Menu option, and skip the confirmation prompt when using the 'R' keyboard shortcut. 








Bug Fixes


*	Opening new soundfiles will now automatically clear Zoom Magnify Mode. This applies to double-clicking Regions from the Regions List or any other manner that SAW32/SAWPlus32 opens a new soundfile into the SoundFile View.





*	Modification was made to allow 29.97 Conform to stay active during SMPTE Generate Mode.





*	Performing a Fade To Next Mix Change after placing Pan information will now work correctly and no longer cause Application Errors.





*	Crossfades with Marked Areas onscreen will now properly trap and warn when the cursor position crossover point is outside the Marked Area boundaries.





*	A PageFault error which could be caused by resizing MT Entries with names larger than 32 characters, has been corrected.





*	The Sequence Control ListBox Window will no longer cover-up dialog box warning messages.





*	Command Line Processing has been fixed to allow spaces in passed SoundFile names.





*	Chase-Trigger Record now functions correctly from Rec-Rdy Mode or Stop Mode.





*	SMPTE Format for Generating SMPTE will now be properly detected from EDL or Preferences without having to first open the Smpte Format/Stripe window.








>----<








Version 1.8





Enhancements


*	The single step up and down areas on the mixer fader will now step in 1db increments if the Shift-Key is pressed while clicking.





*	Fades (drawn as white linked together mix changes) can now be stretched or shrunk to a new size. Place your cursor within the fade boundaries and press the CTRL Key and Left Mouse button near the beginning or end point of the fade. The cursor will change shape and you can now slide it to a new location and release. The fade will be redrawn stretching or shrinking its original curve shape. You can not move the fade beginning in front of a previous mix change or past the end of the fade ending. You can not move the fade ending in front of the fade beginning or past the next mix change. To stretch just a portion of the fade, zoom in and add a mix change somewhere in the middle of the fade to break the join, then stretch either side or both separately.





*	You can now adjust existing volumes and pans within a marked range in the MultiTrack by placing your cursor within the marked area and adjusting the fader or pan knob. All settings within the marked area will be offset according to your adjustments. This is actually rewriting the data values, but is keeping track of overuns and underuns, so you can recover the settings by adjusting in the other direction. Place the cursor on a volume section that is not zero db and the fader will trck the adjustments. Place the cursor on a zero db section and the fader will snap back to zero db after each adjustment, reacting like an offset control.





*	Most Marked Mixer functions now also remove the marked area when finished saving an extra keystroke for most operations.





*	The Next Button on the Mixer Faders has been divided into backward and forward sections. Clicking in the left half of the button will move backward to the previous mix change and clicking in the right half moves forward to the next mix change.





*	Marking the SoundFile View or MultiTrack View can now be accomplished without the need to press the Shift Key while dragging the mouse in the TimeLine area. Clicking the Right Mouse button in the TimeLine area will clear the marks. When Select Mode is on, marking will not occur and the Right Mouse button in the TimeLine area will toggle playback as before.





*	Latching Buttons have now been Color Enhanced for more visibility of latched state.





*	Modifications were made to the 'SMPTE Passed Cue Point' warning message to allow for continued SMPTE display until SMPTE is stopped.





*	Enhancements to the SMPTE Generate support of the Antex Studio Card which now controls all frame rates including 29.97. Selecting 30N or 30D Frames Per Sec in the SAW32/SAWPlus32 SMPTE Stripe/Format box with the SMPTE Conform to 29.97 ON, will generate 29.97 Non or Drop code.





*	The Process and Mixdown options have been enhanced to process in the background if desired. Once the BarGraph window is displayed, pressing the Esc Key is the now the only way to cancel the operation (this eliminates accidental keypresses from aborting); pressing the Enter Key will minimize SAW32/SAWPlus32 and allow processing to continue in the background. You may restore SAW32/SAWPlus32 at any time from the taskbar or other normal Windows methods.





*	A Horizontal ScrollBar enhancement has been made to the MultiTrack and SoundFile Windows. If you accidently click in the scrollbar area and snap the cursor position to the beginning or end of your working view, simply press the Shift Key and click on the scrollbar slider to return you instantly to your last cursor position.





*	The MultiTrack View horizontal scrollbar positioning will now center the MultiTrack cursor much like the SoundFile View.








Bug Fixes


*	Random 'File Not Found Msgs' after entering Names and KeyCodes on a fresh install have been fixed.





*	One more attempt at fixing inaccurate Drive Time Remaining values in the Record Remote Panel for large (> 4 Gig) drives.





*	Meter Bridge will now display properly even when a Relative Zero Offset Time has been set in the MultiTrack.





*	More fixes in the SMPTE modes to give overall tighter SMPTE performance.





>----<








Version 1.7





Enhancements


*	A Notification Message has been added when Saving EDL Files.





Bug Fixes


*	MultiChannel Record Fader Windows will now properly adjust their own respective faders.





*	MultiChannel Record Mode meters will now properly clear the Peak indicator on meter reset.





*	Record Meter margin displays will now correctly max out at 100%.





*	SRP MultiChannel Record will stop properly if you push the machine past its limits and receive the 'Machine Not Fast Enough' message.





*	Changing the Drive Letter in the Record Remote Window when in MultiChannel Record Mode will no longer cause a crash.





*	MT SMPTE Trigger will now wait properly for trigger.





*	MT Chase Trigger will now properly display Wait Message Box.





*	One more attempt at the elusive CompLimiter and Echo Modules Divide By Zero startup crash.





>----<








Version 1.6





Enhancements


*	You may now associate EDL, WAV and SND files in the explorer to automatically run SAW32/SAWPlus32 when you double-click on them. Double-click an EDL, WAV or SND file in the Explorer and an associate dialog will pop up. Select Other for the program and browse to find SAW32/SAWPlus32.EXE. WAV files may already be hooked to some other application and this association can be removed by using the Registry Editor. Open the HKEY_CLASSES_ROOT section and delete the folder for WAV. Now you may freely associate SAW32/SAWPlus32 with WAV files if desired. You may also use a command line hook to auto start SAW32/SAWPlus32 and load and begin playback of a SoundFile or EditList File. Include a /P after the filename in the command line parameters.





*	MultiChannel Record Mode has been activated. This is an exciting new enhancement to the SAW32/SAWPlus32 environment. It allows the MultiTrack to operate more like a standard MultiChannel tape recording system for use in a live recording situation. MultiChannel Record Mode can be toggled On/Off from the MultiTrack Menu. Its state will be saved with the Preferences and each EDL. Once turned On, recording in SAW32/SAWPlus32 operates quite differently than normal. First, each track that you arm for record will now automatically record Mono Audio Data to one of up to 16 SoundFiles at the same time. There will be a SoundFile assigned to each SoundCard input in your SAW32/SAWPlus32 system. If you have 2 stereo devices, you will be able to treat them as four independent inputs, much like a multitrack tape recording system. The Base Filename for each session (or record operation) is first set in the MultiChannel Record Mode Setup option on the MultiTrack Menu. This Base Name can be setup once and forgotten about for an entire session, or you may freely change it many times within the same session. The last Base Name set will save with the EDL. SAW32/SAWPlus32 will append '_Card_1L',' _Card_1R' for each Soundcard assigned to a recording channel. All data will continually be appended to these files and Regions and MultiTrack Entries automatically created during recording. This still retains the power of a Non-Linear System, but on the surface looks more like a simple arm and record Linear type operation. For each push of a MultiTrack Record Button, a small single channel meter will pop up. These meters will attach themselves into a straight line in order of Track assignment. The default input connection will follow the Output Card assignment for the particular track, starting with the L side (if available) then the right side. Dashes will be displayed if all inputs for the default card are already assigned. You may click on the In Display at the bottom of the meter to obtain a list of all available input selections. You may freely assign the input with no regards to the track's output assignment. The small fader icon will pop up an input fader if needed to adjust input level. Simply pressing Record or SRP/Record begins the recording process. Pressing Stop or SRP (to punch out), will automatically place the Region entries on their respective tracks. You may playback the recording, and if you use the Auto-Rewind feature on the main Remote Panel, the play cursor will automatically reset to the exact starting position each time. If you decide to Retake the recording, pressing the Retake Button will remove all the Regions and MT Entries created by the last recording, and reset the file positions to the last position before recording started. In this way you will not waste disk space for recordings you did not like. If you decide to keep the recording but would like to try another at the same spot, press the KeepTake Button, and each Region Name belonging to the last recording will be appended with a unique Take Number and the actual Sample Position insertion point. The MultiTrack will be cleared and the cursor returned to the starting point, but the file positions will not be altered. Therefore recording again will retain the last recorded information. You will also find it easy to do multiple vocal takes or harmony guitar solos etc... by setting up a track to record... assigning the input (which will stay the same between overdubs)... and doing your first track's recording. Now to change to another track and do a harmony part, simply click inside the Track Number Display at the top of the meter. A list of available tracks to move to will be displayed. Select one, and all internal assignments and file handling will be done automatically, so you can begin recording immediately. You can setup a template for typical emulation of a multitrack tape system in this way... Start with a clean EDL... Arrange the first group of tracks on the MultiTrack to point to each installed SoundCard a pair at a time... For instance, Track 1 to Card 1, Track 2 to Card 1, Track 3 to Card 2, Track 4 to Card 2... and so on for each installed pair of inputs... Now, bring up the fader on Track 1 and press the Offset Button... Pan all the way Left... Close the fader and bring up the fader on Track 2 and Offset Pan all the way right... Follow this procedure all the way down for each track assigned to a different SoundCard... Turn on MultiChannel Record Mode and save your EDL and name it 'MultiChannel Record Template', or whatever you like. To instantly setup a MultiChannel Record Mode Session, open this template EDL, enter a Base Name in the MultiChannel Record Mode Setup and immediately save and name your session. Now when you arm a track for record, it will automatically pick up the exact input matching channel, just as if you were using an ADAT or some other type of multitrack tape system. Each track will output through its specific card's output to your external mixer and you will be emulating the feel of your oldstyle multitrack tape system. If you use the CTRL Key when closing the meter panels, all will close at once.





*	The Normal Recording Mode has been altered to take on some of the enhancements introduced in the MultiChannel Record Mode. When recording direct to the MultiTrack, the Stop Button will now automatically drop the recorded region entries onto the track as if you had used the punch in/out feature. This enhancement allows you to listen back to your recording before leaving the Record Panel. All parameters concerning the last recording are retained so that the Retake and KeepTake features can still be used. Retake will remove the last recorded entries and regions, and KeepTake will name them with a unique Take Number and the actual Sample Position where they belong in case you decide to use them in your session at a later time.





*	The MultiTrack Patched FX icon will now display a slightly different broken link when the bypass switch is turned on. This makes it much easier to spot tracks which have patched in effects regardless of the state of the bypass switch.





*	Position Tracking is no longer dependent on Wave Device Drivers. New assembly language code has been added to chase-lock the position to the actual sample buffers as they are clocked out. This should eliminate discrepencies between soundcards as far as position reporting and FX Meter Bridge timing accuracy.





*	The Delete Key will now function the same as the Shift-C Key in the MultiTrack View to clear all mix changes within a marked area if the Mixer Fader is open for the current hot track. If the Mixer Fader is not open then the Delete Key will operate as before... removing the current Seqence Entry (under the cursor).








Bug Fixes


*	The 'S' Key has been trapped during MT Playback. Select Mode should not be allowed to toggle during playback.





*	BuildMix Access Fault Error has been corrected. This is a bug created in 1.5 when changing memory management technique.





*	Chased down more MessageBox windows that were not acting as System Modal.





*	CompLimiter and Echo Module Divide By Zero and Access Error bugs on startup were fixed.





*	MultiTrack Cursor will now report the correct end position when playback stops at the end of the session.





*	Split Stero File has been fixed... it will no longer destroy memory pointers.





*	64 Bit variables are now being used to provide accurate calculations for time remaining on drives larger than 4 gigs.





*	MultiTrack Re-Cue (Mute, Solo, Fader, Bypass, etc...) has been corrected to react properly to mix change info.





*	Warning Message Boxes will now properly display above the Get EDL Region Window.





*	Open Editlist will now correctly identify missing files in the Warning Box.





*	MultiTrack Marked Fades will now correctly update the screen when tracks are ordered out of sequence.





*	Updating a MultiTrack Region Entry and making it smaller, will no longer pull mix changes from non Butt-Spliced entries forward.





>----<








Version 1.5





Enhancements


*	Record Mode in the MultiTrack will now advance the cursor position and perform calls to FX PlugIn Modules for position tracking.





*	Enhanced Memory Management techinques eliminating all use of memory handles.





* 	Enhanced FX API additions to track SMPTEFormat, SMPTEStartOffset and Program Version Number.





*	Crossing into Sample Edit Zoom now changes the cursor to the Sample Edit Mode X cursor. This now alerts the user that sample editing is active. Using the Shift - Left Mouse Button will now grab the nearest sample for adjustment rather than begin a Drag/ Drop Region to the MultiTrack.





*	Pan controls now have a Left and Right Arrow zone. Clicking in either zone with the Left Mouse button will shift the pan control one setting.





*	Adjusting the Track Order now allows virtual up and down scroll of the MultiTrack Window while moving a track number to a new position.








Bug Fixes


*	The Win95 disappearing boot drive problem in the Record Panel Drive / Time Remaining Status window has been corrected.





*	Simultaneous Recording from multiple card drivers will now correctly drop all entries at the proper start position on the MultiTrack.





*	Opening SAWPlus EDL's which contain Break or Loop To Beg Seq Control Entries will no longer crash during the conversion process.





*	The Remote Window and Record Remote Window will no longer appear as a blank button on the task bar when in the Hide/Show on-top mode. They are now designated as floating TollBar Windows.





*	Sample Edit Mode should now work properly with 8 Bit Mono or Stereo Files.





*	Sample Edit Mode wrap around when adjusting the new value to max extremes has been corrected.





*	FullView wave drawing of short files has been corrected.





*	Seq Entry calculations of boundaries and lengths on tracks involving sample-rate conversion or vari-pitch are now done at a much higher resolution eliminating most all of the roundoff error.





*	The Undo function for SoundFile modifications will now restore files to their correct original length even if a paste operation extended the length.





*	Chased after the elusive double MultiTrack Cursor Thread Synchronization problem. Hopefully this will eliminate the appearance of double cursors for good.





*	Changes were made to the EQ, CompLimiter and Echo modules to ease the problem in NT of setting values with the mouse push/pull interface. NT does not seem to send mouse movement messages when the mouse is rapidly pushed past a clipzone. The mouse X motion was widened to include the entire rectangle for each adjustable value. This helps the problem by allowing side movement when the upper and lower limit are reached. By slightly jiggling the mouse when pushing or pulling, you will improve the chances of not freezing the motion.





>----<








Version 1.4





Enhancements





Bug Fixes


*	All Plugins have been recompiled to correct a problem that could trash preset data for other modules. 





*	Setup Program has been modified to detect existing .INI files and not overwrite them during an update operation.





*	The Sample Edit Mode Zoom display has been corrected to eliminate a wrap around line effect that could appear on certain systems using Windows 95.





>----<








Version 1.3





Enhancements


* 	Enhanced Zoom now takes you beyond 1 sample per pixel. ZoomInFull still stops at 1 sample per pixel, but continued use of the ZoomIn function displays the actual sample points as small squares spread out by a fixed number of pixels. You may utilize the Sample Edit Mode by holding the shift key and clicking with the left mouse button on or near a particular sample square. You may then change the sample value by pushing up or down with the mouse, and the SoundFile and PeakDataFile will be instantly updated. Note that you may also use the Up and Dn amplification buttons for finer value alterations. This feature offers an incredibly easy method of pop and scratch removal. Simply zoom in and adjust the samples that are radically different to create a smooth curve transition with the adjacent samples.





*	The Shift-V Clear Marked Vol Changes option will now physically remove any mix entry within the marked area that does not have a unique pan setting. If there are no enclosed pan changes this function now works exactly like the Clear Marked Vol And Pan Changes function, removing all entries within the marked area.





*	The Shift-P Clear Marked Pan Changes option will now physically remove any mix entry within the marked area that does not have a unique volume setting. If there are no enclosed volume changes this function now works exactly like the Clear Marked Vol And Pan Changes function, removing all entries within the marked area.





*	Fade Out / Fade In Marked are now transparent to pan changes within the marked area, superimposing the fade over top any existing pan information.





*	Crossfades are now transparent to pan changes within the marked or overlapped area, superimposing the crossfade over top any existing pan information.





*	SRP Recording has been enhanced. The multitrack cursor is now independently controllable and will no longer be automatically updated at the end of the recording process to the end of the newly recorded entry. You may now use the Remote Panel Auto Rewind button to force the multitrack cursor back to the original start position after you stop recording, ready for another take. You may now punch-in independent of the playback starting position, and when you stop recording, the cursor will return back to the original starting position, not the recording punch-in position. By marking the desired recording range in the multitrack, you can simply press SRP and the recording will automatically punch-in and out at the proper positions. When you stop, the cursor will be reset ready for another take. By marking the end position much beyond where you will stop recording, you will have an automated in point but you will stop the recording manually. Doing things this way allows you to decide on retaking or keeping the last take, which can make better use of your harddrive space when doing multiple take recording sessions. 





*	Enhanced error checking during EDL saves will warn of any trouble during the save operation. The Update EditList Function will now beep through the computer speaker as an indication that all went well.








Bug Fixes


*	Right Clicking on an empty Regions List will now correctly display warning message box.





*	Changes were made to most warning message boxes to latch them to the main window instead of the desktop.





*	More work was done on the elusive MultiTrack Waveform Display causing track sync slippage. This time, it should be fixed.





*	The Update MultiTrack Entry function now functions correctly when modifications are being made near the MultiTrack Zero position.





*	Fade To Next Mix Change will now correctly allow you to start the process from a position directly on an existing mix change. This now works exactly like the Sweep Pan to Next Mix Change.





*	MultiTrack Display Buffer Size adjustments were made to help eliminate waveform display problems when doing samplerate conversions from 11025 to 48000.





>----<








Version 1.2





Enhancements


*	Slopes are now displayed in the fader view on the MultiTrack. A Green Line will show the slope of each mixer entry and slope adjustments are displayed immediately when altered. Note that volume changes are instantaneous at entry boundaries that are not butt-spliced to another entry.





*	A new Mix Menu Option called Fade Curve Setup has been added. This allows selecting and modifying the current Fade Curve parameters used for MultiTrack Fades. This option can now remain on screen while creating groups of fades, allowing rapid selection of different fade parameters. The Setup Window has been moved from the Fade To Next Mix Change option.





*	Marked Fades and Crossfades are now automatically adjusted to within entry boundaries. They will no longer write into an empty area on a track.





*	Default Slope Factor will now save with the preferences. Simply set the slope value you desire and save preferences.





*	The Undo command has been extended to handle many more EDL modifying operations.





*	A new Info Menu Item called Latest Release Notes has been added. Clicking on this option will display this document directly.





*	A new Info Menu Item called Help Tutorial has been added to take you straight to the tutorial section.








Bug Fixes


*	Output Track mix changes are now handled correctly. They will no longer jump to Entry boundaries that are on other tracks.





*	Mix changes will no longer jump entries on tracks that are out of normal track order.





*	MultiTrack display waveform redraws should no longer cause track sync slippage.





*	EQ, CompLimiter and Echo Load and Save Presets are now working properly.





*	CompLimiter compressor and limter functions will no longer shift the pan position when multiple units are patched.





*	Currently selected Audio Card is now properly displayed in the Record Panel.





*	Assign Regions to MIDI Notes should now work correctly.





*	BuildMix To Output Track should now do SampleRate Conversion properly.





*	BuildMix functions should now correctly identify a marked range even if the range is not visible on the screen.





*	Playing a blank area on an Output Track with the Output Track Solo engaged will now properly play silence.





*	Joystick motion sensitivity is now set high while SAW32/SAWPlus32 is active to help eliminate possible streams of joystick motion messages from overly sensitive joysticks. This could cause system slowdown. The joystick services are used to detect the gameswitches for certain operations in SAW32/SAWPlus32.





>----<








Version 1.1





Enhancements


*	Enhanced CrossFades now also use Fade Curve Parameters for more precise control.








Bug Fixes


*	Loading SAWPlus 16 Bit EDL's should now correctly retain FX Module settings.





*	SMPTE Format should no longer change to 24 FPS when opening the Set SMPTE Start Offset Window.





*	FX Echo should now correctly process between Sequence Entries.





*	WAV headers are now correctly written during Recording and Build Mix operations.





*	Split Region And Cut MT Entry operations should no longer corrupt Sequence Entry information.





>----<








Version 1.0





Enhancements


*	Flat 32 Bit Native 95 / NT Code.





*	Enhanced Wave Audio MultiThreaded handling routines can take advantage of Priority Threading and Multi-Processor support in NT.





*	Enhanced Midi/Smpte MultiThreaded handling routines can take advantage of Priority Threading and Multi-Processor support in NT.





*	Enhanced cursor and position update MultiThreaded handling routines can take advantage of Priority Threading and Multi-Processor support in NT.





*	Enhanced Disk handling routines.





*	Less Hard Disk head seeks per MultiTrack Loop.





*	Larger Wave buffer size requires less Interrupts per second.





*	The MultiTrack has been expanded to 24 tracks of  mono or stereo data, allowing a maximum of 48 tracks of Realtime Audio Playback on a high performance machine.





*	Support for up to 8 Stereo Wave Devices has been added, allowing a maximum of 16 physical channels In and Out. 





*	Fader Vol Resolution has been enhanced to 1/4 db steps.





*	Each Mix Step is now ramped according to a Slope Setting, resulting in enhanced resolution below 1/1000 of a db and smoother noisless fades.





*	New Fade Curve Window allows selection of different internal high precision Fade Curves with Step Size adjustment. The design allows for the creation, saving  and selection of custom curves to be implemented in a future update.





*	Marked Area FadeOuts and FadeIns also use Fade Curve Parameters for more precise control.





*	Enhanced Keyboard shortcuts for fade functions bypass all prompts allowing much faster operation.





*	Mix changes are no longer permitted between Sequence Entries. The cursor is automatically advanced to the start of the next entry or the end of the previous entry if there are no entries past the cursor position.





*	Long FileNames.





*	Enhanced Zero Cross lowest energy point detection.





*	MultiTrack Smart Tab will now Re-Center the screen only if a scroll was needed.





*	'=' Key can now be used to instantly center the cursor position on the SoundFile or MultiTrack display.





*	Enhanced VariPitch Resolution to 1/100 of a percent in the Time Mode.





*	Enhanced 32 Bit API stores all FX Module Settings directly in the EDL, allowing all EDL Versions 1-9 to now correctly identify different FX Settings.





*	Support for the Antex Studio Card SMPTE Generator has been added.





*	New Keep Take Button In Record Panel allows you to keep takes and instantly do another. All takes are automatically regioned for easy later retrieval.





*	New Auto SRP/Rec Button link. Presses both buttons together without the use of the Shift Key. Use this in conjunction with the Retake Button to assure that each take is started at the same position reference.





*	GamePort Switches are now supported through the Joystick services, allowing GamePort Switches to function properly in both 95 and NT. Simply make a 15 pin din plug to emulate a joystick. Solder a 150K resistor between pins 1 and 3. Another 150K resistor between pins 1 and 6. Switch or Relay 1 goes between pins 2 and 5. Switch or Relay 2 goes between pins 7 and 5. Go to the Control Panel in Windows and select Joystick. Choose Custom and test your buttons.








Bug Fixes








Removals


*	Session Archiving has been removed. With so many tracks available and so many new features to support, including the soon to come 32 Bit Data Path, Archived Sessions to Audio DAT has become impractical. We now recommend using inexpensive Data Tape Backup Devices, Jazz Cartridge Type Devices, or CDROM to backup sessions.





*	ChaseLock Resolve And Observe options have been removed. Newer SoundCards can now handle lock to LTC, VITC, WordClock, Video Sync etc. at a hardware level, outperforming our software emulation. We recommend looking into one of these cards if this feature is needed.





*	Analog / Digital switch in the Record Panel has been removed. This function required specific proprietary code for each soundcard supported. Most new soundcards now have many proprietary functions that we cannot support directly. Each card will most often have its own mixer/utility applet that will control all the special features of that card.





>====<





